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Chapter 1: Getting Started
Introduction

The SE 300 Ultra Solder Paste Inspection User Guide provides comprehensive information 
about the Solder Paste Inspection application. If you have any questions that are not answered 
by this guide, contact CyberOptics Customer Service and Support. For more information, refer 
to Technical Support on page 78.

Prerequisite Knowledge
● Moderate computer experience 

● Moderate Windows® experience

● Prior knowledge of solder paste inspection process

Documentation

Documentation for the SE 300 Ultra inspection system consists of the following information:

● SE 300 Ultra Hardware Reference

Provides an overview of SE 300 Ultra components, instructions for how to install and 
maintain the SE 300 Ultra system, parts replacement information, and system 
specifications.

● SMT Teach Tools User Guide

Provides an overview of SMT Teach tools, as well as instructions for teaching a panel using 
a variety of methods.

● Teach Online Help

Provides task-based, step-by-step procedures for using the Teach applications and 
describes the software controls.

● Solder Paste Inspection Online Help

Provides task-based, step-by-step procedures and descriptions of the software controls for 
the Engineering Interface.

● SE 300 Inspection Online Help

Provides task-based, step-by-step procedures and descriptions of the software controls for 
the SE 300 Inspection application.
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Overview
Overview

The SE 300 system is an inline solder paste inspection system that is normally placed just after 
the solder paste screen printer. The main uses of the SE 300 system are:

● To intercept defective prints before components are placed onto them so the boards can be 
washed and reprinted.

● As a tool to accurately measure solder paste in order to establish process tolerances. 

● To monitor the printing process to ensure that the solder paste remains consistent and 
within established tolerances.

SE 300 System Components

The SE 300 System consists of the following components.

Hardware

The major hardware components of the SE 300 system include: 

● A conveyor system that accepts panels from an upstream machine, clamps them during 
the inspection process and then releases them and passes them to the downstream 
machine.

● An optical sensor that flashes light on the surface of the panels, captures images, and 
processes those images to yield measurement data. 

● A light pole and alarm to notify operators of events that require their attention. 

● An internal processor running the SE 300 system real-time software (explained below). 

● A Windows system running the Teach and Solder Paste Inspection applications (explained 
below). 

Software

The major software components of the SE 300 system include: 

● Real-time software: Controls the SE 300 system hardware, including the conveyor system, 
optical sensor, light pole, and audible alarm. 

● SE 300 Inspection: Operators use the SE 300 Inspection application to control the 
inspection process and to view the inspection results. 

● Solder Paste Inspection: Engineers use the Solder Paste Inspection engineering interface 
to set up system security and inspection options, as well as perform inspection operations 
restricted to engineers.

● SMT Teach: Engineers use the Teach application to create and maintain SRFFs for each 
assembly to be inspected. SRFFs define the dimensions and characteristics of the panels as 
well as what should be inspected.
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Chapter 1: Getting Started
Solder Paste Inspection Window

The Solder Paste Inspection application is a Windows application and uses familiar Windows 
screen elements. The basic parts of the Solder Paste Inspection window are identified below. 

Tool Bar

Control Buttons

Dialog Bar

Output Palette Panel View

Tool Palette
4 SE 300 Solder Paste Inspection User Guide



Using the Panel Tree
Using the Panel Tree

The Panel view displays a list of elements contained in the panel in the Panel Tree in the left 
side of the window. 

Panel elements are the building blocks used to describe a panel. The elements fit together in a 
hierarchical manner displayed by the panel tree. You can use the panel tree to locate elements 
on the panel. When you select an element in the tree, all elements that share the same 
characteristics appear in bold type. In the Panel View, the selected element is outlined in a 
dashed white line. 

Selecting Elements

Click on the name of the element in the panel tree. 

● All linked elements (elements which share the same characteristics) appear in bold type.

● In the Panel View, the selected element is outlined in a dashed white line. All linked 
elements are outlined in a solid white line. All “children” of the selected element are 
shown in dashed lines of their original color.

Finding an Element

A search function helps you find a given element in the Panel View, Image View, or Fiducial 
View. 

1. Click the data view you want to search. 

2. From the View menu, choose Find. 

3. Enter all or part of the element name to find. 

4. To limit your search, you can check either or both of the following boxes: 

● Match Case: Only finds element names whose capitalization matches the search text 
you type. For example, entering dsp will not find DSP. 

● Whole Word Only: Only finds elements whose full names match the search text you 
type. For example, entering C1 will not find C16. 

5. Click OK.

The system finds the element and marks it in bold in the panel tree and in the Panel View, 
Image View, or Fiducial View. 

6. To find another element with the same name, choose Find Next from the View menu. 

i
Note: Elements that match the search text are found in the order they appear in the SRFF, not 
in the order they appear in the panel tree.
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Chapter 1: Getting Started
Using the Panel Image

The panel image is a graphical representation of elements in the panel tree. Elements in the 
panel image are displayed in the same color as the icon appears in the panel tree. For example, 
component locations, part numbers, and packages, are shown in blue. If an element does not 
appear in the panel image but is present in the panel tree, set the Display Options so that the 
element type is displayed. See Setting Panel View Display Options on page 8 for more 
information.

When you select an element, either in the panel tree or the panel image, it is displayed in the 
Panel View using a sold white line (in the panel tree, it appears in bold type). All linked 
elements (elements which share the same characteristics) are outlined in a dashed white line. 
All “children” of the selected element are shown in dashed lines of their original color.

Selecting Elements in the Panel View
1. If the tool palette is not open, click , or on the View menu, point to Palettes and click 

Tools.

The Tool palette opens on top of the panel image. You can drag this palette to any place on 
your screen.

2. Click .

3. Click on an element in the Panel View.

● In the panel image, the selected element is outlined in a solid white line. All linked 
elements (elements which share the same characteristics) are outlined in a dashed white 
line. All “children” of the selected element are shown in dashed lines of their original 
color.

● In the panel tree, all linked elements appear in bold type.

Using the Navigator

The Navigator palette provides a map of the entire panel. It shows the outlines of the panel 
description and the task elements that make up the panel. When you select elements in the 
panel tree or the Panel View, they are also highlighted in the navigator palette using the same 
color conventions as the Panel View. You can use the Navigator to move to or zoom in on 
specific areas in the Panel View.

1. On the toolbar, click  to open the Navigator palette.

● A crosshair marks the origin of the selected element.

● The selected panel description or task is outlined in a solid white sold line.

● Each linked element (throughout the entire panel) is outlined in a dashed white line.

● All “children” of the selected element (throughout the entire panel) are shown in 
dashed lines of their original color.

2. Drag around an area in the Navigator palette to zoom the Panel View image to that area.

3. Double-click on a position to zoom the Panel View image to that position in the active 
Panel View.
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Using the Panel Image
Zooming the Panel View Image
1. If the Tool palette is not open, click , or select Tools from the View Palettes menu.

The Tool palette opens on top of the panel image. You can drag this palette to any place on 
your screen.

2. In the panel view, select an element to zoom into view.

3. Click a zoom button:

Panning the Panel View Image
1. If the Tool palette is not open, click , or select Tools from the View >Palettes menu.

The Tool palette opens on top of the panel image. You can drag this palette to any place on 
your screen. 

2. Click . 

3. Click in the panel image and drag in the direction that you want to view.

Changing Background Contrast
● To increase the contrast between the background image and object outlines, select Low 

Contrast Backgrounds from the View menu.

Zoom: magnifies the image in the Panel View. Right-click with the 
zoom tool active to zoom back out in the image.

Zoom All: returns to the original view.

Zoom Selection: select the element to magnify, then click the zoom 
selection button.

Zoom Parent: select the element to magnify, then click the zoom 
parent button. This zooms in on the parent of the selected element.
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Chapter 1: Getting Started
Setting Panel View Display Options

You can select which elements and which aspects of the elements to display in the Panel View.

1. On the View menu, click Display Options. (or click  in the tool palette).

The Display Options dialog box opens. The upper portion of the dialog box lists the 
symbols that can be displayed and the lower portion of the window lists elements by 
name.

Elements in the left column are specific objects that can be further defined by any or all of 
the symbols listed. Elements in the right column are definitions and use only the Name 
and Bounding Box symbols.
For example:

The following image shows the Panel View with the Element Location and the Symbols 
Name, Vector, and Jack, and Bounding box selected. In addition, both the Product and Process 
Properties options are selected.

2. Select the display settings according to your preferences.
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Setting Units of Measure
Setting Units of Measure

Units of Measure apply to the entire panel file. You can set units for distances (mm, microns, 
mils, inches) and for angles (degrees, minutes, quadrants, radians, seconds). If you do not set 
these values, the system defaults to meters for distance and degrees for angles.

1. On the Tools menu, click Options.

2. Click the Units tab.

3. Select options for Angle Units and Distance Units, and click OK.

If you save the SRFF, the current units are saved along with it. Otherwise, any changes to the 
units are applicable only for the current session.

Precision Tolerance Settings

The Precision area of the Units tab contains the Digits and Per Dimension areas. The Digits 
area has three levels for Maximum, Moderate, and Minimum number of precision digits. The 
number of digits is linked to the unit type selected.

The maximum digit level corresponds to the current settings and is based on the amount of 
measurement precision that the SE 300 Ultra can deliver. The moderate and minimum digit 
levels reduce the used and reported amount of measurement precision.

The Per Dimension area contains the Height, Area, and Volume boxes. The values displayed 
are representative measurement values for each dimension and change the display based on 
the option selected in the Distance Units list and the selected Digit level.

The amount of stored precision for each unit and its three dimensions and three precision digit 
levels is reflected by the number of places to the right of the decimal point.

For example, for millimeters, select Maximum to provide four decimal places for height, area, 
and volume measurements. Select Moderate to provide three decimal places for each 
dimension. Select Minimum to provide two decimal places for height, area and volume.

The values in the Per Dimension box changes based on the selection of distance units and digit 
level.
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Chapter 1: Getting Started
Using Data Views

Data views are your windows into the inspection process. Data views can show an image of 
the panel and the data that the system collects about it. You can open more than one data view 
at a time. Once you have a set of views or windows open, you can save the set so that the same 
grouping appears the next time an SRFF is opened.

➢ To open a data view

1. Click  to open the Panel View. 

2. From the panel tree in the left pane of the Panel View, either:

● Select the element of interest in the panel tree and then click the toolbar button that 
corresponds to the data view to open, or 

● Drag the desired element from the Panel View and drop it into an open data view. 

3. Customize the data view as necessary. Press the F1 key for information about the current 
data view. 

4. If you have multiple data views open, you can arrange them so that all of the necessary 
information is visible. To save the set of data views currently open:

● Click  (to clear any previously saved sets first) or

● Click   (to revise the previously saved set to match the views currently open). 

Tips
● You can open a data view by selecting an element in the failure report view and then 

clicking the tool bar button for the data view you want to display. 

● You can also open a data view by selecting View from the Window menu and then 
selecting the data view to open.

● To change an open data view to display data for a different element, drag and drop the 
element into the open data view window. (An  indicates you cannot select that element 
type for a given data view.) 

● In data views that contain tabular data, you can show/hide columns by right-clicking in 
the table header and choosing which columns to show in the dialog box that opens. 

Data View Summary

 Panel View

Use the Panel View to monitor the inspection and to select the elements for which you 
want to view data. 

 Trend Chart 

Use the Trend Chart to watch for patterns in the inspection data. The graph makes it easy 
to monitor the inspection results for consistency and to spot trends indicating that the 
measurements are drifting out of spec. 

 Numeric Report

Use the Numeric Report to display and print a panel-level report of the inspection run. You 
can also display numeric reports at the image (board), location (component) and feature 
levels, but they may provide more data than is practical to print. 
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Using Data Views
 Failure Report 

Use the Failure Report to check the details about any failures that occur during the current 
inspection run. You can print a copy of the failure report at the end of the inspection run to 
provide a record of failures. 

 Defect Review

Use this window to review failures found during the inspection of the current panel. The 
Defect Review palette includes a failure pane to display failure data and an image pane to 
show the panel image. 

 Image View

Use the Image View to display an image of that corresponds to the SE 300 system’s field of 
view. 

 Fiducial View 

Use the Fiducial view, if necessary, to adjust the illumination of the fiducials to ensure that 
the SE 300 system sensors can find them accurately. 

 Skip Mark View 

Use the Skip Mark view, if necessary, to adjust the illumination of the skip marks to ensure 
that the SE 300 system sensors can find them accurately. 

 Barcode View

Use the Barcode view, if necessary, to adjust the illumination or barcode type of a barcode 
to ensure that the SE 300 system sensors can find them accurately and to manually correct 
a barcode read.
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Chapter 1: Getting Started
Setting up System Security

The SE 300 system security applies a system of Groups and Users to determine which logon 
names can access a given function. The default setup allows full access to all SE 300 system 
features for all users except for access to the security feature itself. By default, only a 
Supervisor logon has rights to change the security setup. 

In some cases, the SE 300 system logon screen does not appear. This means that your 
administrator has set up your account to automatically log on to the SE 300 system using your 
system account.

Setting up system security requires adding users to the system through the Windows User 
Manager and assigning access using the SE 300 system security system. For more details about 
implementing SE 300 system security, refer to the SE 300 System Hardware Reference.

➢ To assign access to groups

1. From the Security menu, select Secure Assignments.

2. Select a Group from the list. You should have the following four groups from which to 
choose: Supervisors, Engineers, Lead Operators, and Operators.

3. To add access to a Secure Area, select the name from the Unassigned list and click Add.

4. To remove access to a Secure Area, select the name from the Assigned list and click 
Remove.

5. Click on OK to save your changes or Cancel to close the window without making changes. 
When you click OK, your changes are saved to a file named SE300.sec, located in the 
default security directory. The settings in this security file are loaded each time the 
application is started

i
Notes:
Secure Areas must be assigned to a group.
You must be included in a group that is assigned the Security Setup Secure Area in order to 
make changes to Security Assignments.
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Chapter 2: Setting Up an Inspection
Overview

Before you can run an inspection, you need to create a panel (SRFF) file using the Teach 
application. For more information on creating panel files, see the Teach application and the 
online help. 

➢ To set up the Solder Paste Inspection application

Prior to starting an inspection, you may have to adjust some of the Solder Paste Inspection 
settings: 

1. Set options for saving data: 

● To save data in XML format, see Saving Inspection Data in XML Format on page 15.

● To save data for use with CyberOptics Process Insight™, see Saving Inspection Data in 
XML Format on page 15.

● To save data in CVS format, see Saving Inspection Data in CSV Format on page 17.

2. Set up responses for system events. 

See Setting Up Responses to System Events on page 19.

3. Set the Conveyor Control option to reduce inspection time. 

See Reducing Inspection Time on page 23.

➢ To check the printer

You can use the SE 300 system to check your solder paste printer setup using the registration 
measurements provided by the Solder Paste Inspection application. See Checking Paste 
Registration on page 47. 

➢ To adjust illumination levels

If the system is not locating fiducials or skip marks correctly, try adjusting the illumination 
level:

● See Adjusting the Illumination Levels for Fiducials on page 24.

● See Adjusting Illumination Levels for Skip Marks on page 26.

i Note: For unusual pad configurations that may require additional offset values, or if you want 
to use offset values entered in Teach, see Adjusting Height Calculations on page 28. 
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Saving Inspection Data
Saving Inspection Data

Inspection data can be saved as XML, HTML, text, or comma-delimited (CSV) ASCII text files 
to support remote monitoring and analysis. 

● Save Inspection results as XML data (for Process Insight) 

● Save inspection results as CSV data 

● Save Defect Images 

Saving Inspection Data in XML Format

Use this procedure to save inspection data to a data file or files in XML format. If you create an 
Extensible Stylesheet Language Transformations (XSLT) file, you can customize the final 
output, including which data to save and whether to save it in an xml file, html file, or text file. 
If you do not use an XSLT file, all of the inspection data is saved to an xml file using the 
default XML schema. 

Use the XML data output format to save inspection results for viewing in CyberOptics Process 
Insight version 3.1 or later.

1. From the Tools menu, choose Options. 

2. Choose the File Handling tab. 

3. If you are using a handheld barcode reader, in the SRFF Directory section, click the Browse 
button and navigate to the folder containing the SRFF. The system uses this pathname to 
correlate the scanned panel name with the SRFF. 

4. In the XML section, select either Standard XML or ADO Compatible XML. ADO-compatible 
format is more usable by applications developed in the .net environment. 

5. Also in the XML section, select the folder in which to store the XML data. If you are using 
Process Insight, this folder must be shared to a location accessible by the server running 
Process Insight. Make sure that the location has adequate space for all of the data. 

● Select Output folder and then click the Browse button next to the Output field (at the 
top of the dialog box) and navigate to the folder to store the inspection data files (if not 
done already). Using this option saves the data in a folder named XML within the SRFF 
data file structure.

● Select Home folder and then click the Browse button next to the XML Output Home 
field and navigate to the folder location in which to store XML data. Using this option 
saves the data in the specified location separate from other SRFF data files.

6. If you have an Extensible Stylesheet Language Transformations (XSLT) file, select XSLT 
Output and then navigate to XSLT file to use in the XSLT Source field. 

7. Click OK. 

i
Note: The XSL file does not need the “cyber:” namespace identifier in order to match the 
<SE300.INFO> block. If you have tested the XSL file in an application that requires that 
identifier, remove the identifier before loading the XSL file into the Solder Paste Inspection 
application. 
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Chapter 2: Setting Up an Inspection
Saving CSV Data for Process Insight

Use this procedure to save inspection data for viewing with CyberOptics Process Insight 
version 3.0 or earlier. Process Insight is typically installed on a separate computer that also has 
Microsoft SQL Server installed. Process Insight watches the Output Directory specified in the 
File Handling tab and transfers the data to the SQL Server database where it can be viewed 
and analyzed.

For Process Insight version 3.1 or later, save inspection data in XML format. For details, see 
Saving Inspection Data in XML Format on page 15.

1. On the Tools menu, click Options.

2. Click the File Handling tab.

3. If you are using a handheld barcode reader, in the SRFF Directory section, click the Browse 
button and navigate to the folder containing the SRFF. The system uses this pathname to 
correlate the scanned panel name with the SRFF.

4. In the Output Directory section, click Browse and navigate to the folder in which to store 
the data. This folder must be shared in a location accessible by the server running Process 
Insight. Make sure that the location has adequate space for all of the data.

5. In the CSV File Output area, select the Log data to a separate file for each panel inspected 
and Use detailed format check boxes.

6. In the Data Level area, select the Write Feature-level data file(s) check box.

7. Click the Advanced tab.

8. In the Statistical Process Control area, select the Output Location Tolerances check box. If 
selected, the SE 300 system generates a location tolerance file used by Process Insight to 
configure report data.

9. Click OK. 
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Saving Inspection Data
Saving Inspection Data in CSV Format

Use this procedure to save inspection data to files in CSV format. The CSV file can then be 
opened off-line in a spreadsheet program for analysis. CSV files can also be read by Process 
Insight version 3.0 and earlier. Data is not written to the CSV file for features for which 
inspection is not enabled.

1. From the Tools menu, choose Options.

2. Choose the File Handling tab. 

3. If you are using a handheld barcode reader, in the SRFF Directory section, click the Browse 
button and navigate to the folder containing the SRFF. The system uses this pathname to 
correlate the scanned panel name with the SRFF. 

4. In the Output Directory section, click the Browse button and navigate to the folder in 
which to store the data. The system creates a sub-folder named CSV within the selected 
folder. All data files for the SRFF are stored in the CSV folder. Make sure that the location 
has adequate space for all of the data. 

5. In the CSV File Output section, indicate how you want to save the inspection data by 
setting Log data to a separate file for each panel inspected: 

● Checked: saves inspection data for each panel in a separate file using the filename 
format: 

panelfile.barcode or #panel ID.timecode.spi.csv. When you use this option, you can access 
data from previously inspected panels while the current panel is being inspected. 

● Unchecked: saves inspection data in a single data file using the filename format: 

panelfile.spi.csv. 

6. Select whether to Use detailed format in the data file: 

● Checked: includes measurement-specific pass/fail status, nominal values, and failure 
tolerances in the inspection data files. When a data file contains this information, the 
filename includes the letter T. For example: 

panelfile.T.1234567.3da56a0.spi.csv (for data saved in separate files for each panel), or

panelfile.T.spi.csv (for data saved in a single file) 

● Unchecked: logs only measurement data and a single pass/fail status for each feature, 
location image or panel. 

7. In the Data Level section, select the type of data to save. You must select at least one of the 
four options to save any data in a data file. Each type of data (feature, location, image, or 
panel) is saved to a different file or set of files. 

8. Click OK. 
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Chapter 2: Setting Up an Inspection
Saving Defect Images

Use the Defect Review window to save a video image and height map of a defective feature. 
To save defect images automatically, use Teach to set up a Collect Image response to a Panel 
Event failure.

1. Either set up a stop response to inspection failures or make sure that you stop the system 
before the panel to review is released to the outbound conveyor. 

2. Click  to open Defect Review. 

3. Click . A video image and height map of each defect are saved in a folder named 
DefectReview within the SRFF panel file directory. In addition, an XML file is created that 
contains failure data for the feature. 
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Setting Up Responses to System Events
Setting Up Responses to System Events

You can configure the SE 300 system to perform an action when key system events occur. For 
example, you can have the system turn off all alarms when a new panel is loaded.

1. On the Tools menu, click Options. 

2. On the System tab, click   and then select an event to add.

● Panel Loaded: The system has moved a panel into position and clamped it.

● Panel Unloaded: The system has unclamped a panel and passed it down the line.

● Inspection Begin: The system begins to inspect a panel.

● Inspection End: The system completes the inspection of a panel.

● System Error: A system error has occurred, stopping machine operation.

● Safety Engaged: Safety interlocks have been engaged, either because the operator 
pressed the Emergency Stop button or because the operator has opened the cover.

● Safety Cleared: Safety interlocks have been cleared. Occurs when the cover is closed or 
the Emergency Stop button is pulled out.

● Input 0 Engaged: The SE 300 system receives a signal over the first spare input channel. 
Occurs when some equipment connected to the SE 300 system signals that an event has 
occurred.

● SPC Alarm 1: Activates a response when a high-priority SPC alarm event occurs. A 
Level 1 Event (High) alarm action must also be set in the SE 300 Inspection application. 
By default, the red light will flash as a response to this event, but the response can be 
changed in the Response Group.

● SPC Alarm 2: Activates a response when a medium-priority SPC alarm event occurs in 
SE 300 Inspection. A Level 1 Event (Medium) alarm action must also be set in the SE 300 
Inspection application. By default, the yellow light will flash as a response to this event, 
but the response can be changed in the Response Group.

● SPC Alarm 3: Activates a response when a low-priority SPC alarm event occurs. A 
Level 1 Event (Low) alarm action must also be set in the SE 300 Inspection application. 
By default, the yellow light will turn on steady as a response to this event, but the 
response can be changed in the Response Group.

● Input 0 Cleared: The SE 300 system stops receiving a signal over the first spare input 
channel.

● Input 1 Engaged: The SE 300 system receives a signal over the second spare input 
channel. Occurs when equipment connected to the SE 300 system signals that an event 
has occurred.

● Input 1 Cleared: The SE 300 system stops receiving a signal over the second spare input 
channel.
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Chapter 2: Setting Up an Inspection
3. Add a response group by selecting the event, clicking  , and then selecting 
Response Group. 

4. Click the plus sign   for the event to expand the response group.

5. Add responses for the event by selecting Response Group, clicking   and 
then clicking the type of response you want to add.

● Alarms Response: To turn a pole light or horn on or off. (The flash response is not 
implemented.) 

● Message Response: To display a message on the Messages tab of the output palette. 

● Outputs Response: To activate one of the spare digital outputs.

● Skip Inspection: To pass (default) or hold the panel without inspecting it.

● Stop: To stop the SE 300 system after the inspection of the current panel is complete.

6. Click the plus sign   for the response group to show the responses.

7. Click the response in the tree diagram and then specify the details of the response.

8. Click OK to save the changes and close the Options dialog box. 

Tips
● The Stop response has no effect when used with the Inspection End event.

● Use the Teach application to set up responses for inspection failures and other 
measurement events.

● Make sure that you set up event and response pairs to turn off responses from the previous 
inspection. For example, set up a Panel Loaded event to turn off the signal pole lights.

● System Events and Responses can be password-protected to prevent unauthorized 
changes to the inspection process.
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Using a Panel Diverter
Using a Panel Diverter

If you are using a panel diverter to divert failed boards from the main conveyor, you must 
enable the Panel Release feature and set up inspections to automatically reset the diverter 
control when an inspection begins. 

When the Panel Release feature is enabled, the panel diverter is controlled by Output 0: 

● On indicates panels are diverted.

● Off indicates panels are not diverted.

➢ Turning on the Panel Release Feature

1. On the Tools menu, click Options.

2. On the Advanced tab, click Enable Panel Release Control. 

3. Click OK.

➢ Resetting the Diverter at Inspection Begin

1. From the Tools menu, choose Options.

2. From the System tab, click   and select Inspection Begin. 

3. Select Inspection Begin, click   , and then select Response Group. 

4. Click the plus sign   to show the response group.

5. Select Response Group, click , and then click Outputs Response. 

6. Click the plus sign   to show the Outputs Response group.

7. Select Outputs Response. The outputs responses are shown in the right pane of the dialog 
box.

8. For Output 0, pull down the list of options and select Off.

9. Click OK.
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Changing the Board Image Level for 
Inspection Results

Specify the level at which an Image is considered a board. This information used when 
reporting results in the Board Images Passed and Board Images Failed counters during 
inspection. For example, level 2 means that boards on multi-board panels are one level below 
the root.

1. On the Tools menu, click Options.

2. Click the Advanced tab.

3. In the Board Image Level, specify the level of board images in the SRFF panel tree to 
include in inspection results.

4. Click OK.
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Reducing Inspection Time
Reducing Inspection Time

You can reduce overall inspection time by setting the SE 300 system to load a panel as soon as 
the outbound sensor detects the panel and the downstream conveyor is not busy. This setting 
eliminates the time needed for the panel to clear the outbound sensor before loading a new 
panel into the system.

The Simultaneous Load/Unload check box is selected by default. You can verify that it is 
selected and clear it if necessary.

1. On the Tools menu, click Options.

2. Click the Advanced tab.

3. In the Conveyor Control area, select the Simultaneous Load/Unload check box.

4. Click OK.

i
Note: If Simultaneous Load/Unload is turned on and you press  when the SE 300 system is 
releasing a panel, the SE 300 system finishes releasing the current panel, moves the next panel 
into position, clamps it in place, and then stops. If the system does not receive a Board 
Available signal, the SE 300 system stops when it releases the current panel.
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Adjusting the Illumination Levels for Fiducials

Fiducials are used as reference points for the panel inspection. If the system cannot locate the 
fiducials, the panel cannot be inspected. The system may not be able to locate a fiducial if the 
light levels do not yield enough contrast between the fiducials and the surrounding material. 
Use the following procedure to adjust the illumination of the fiducial so that it is more easily 
seen against the background material. 

1. Before the system releases the panel, click . 

2. Open a Fiducial View for the fiducial you want to examine. If you want to adjust the 
illumination levels for all fiducials on the panel, select any fiducial. 

● From the Panel View, select the fiducial (  icon) and then click   or 

● Drag the desired fiducial (  icon) from the Panel View and drop it into an open 
Fiducial View. 

3. To check the current illumination settings, click  Get Image. 

4. Check the image of the fiducial and the results: 

● Score: indicates how well the fiducial read by the sensor matches the fiducial 
definition. A high score indicates a good match. 

● Confidence: is a measure of how unique the fiducial match is within the field of view. A 
high confidence value is considered good. 

● Pass/Fail indicates whether the system will be able to find the fiducials with the current 
settings (Pass) or not (Fail). 

5. Adjust the settings as necessary: 

● Under Light Source Illumination, adjust the amount of diffuse and specular light as 
necessary. The higher the percentage, the brighter the light. 

● Under Transition, indicate whether the fiducials are lighter than the surrounding 
material (Dark-To-Light) or darker than the surrounding material (Light-To-Dark). 

6. Click  Get Image to test your new settings. 

7. Continue to adjust and test your settings, as necessary, until you have achieved a high 
score and high confidence level. 

8. Apply your settings in one of the following ways: 

● Click Apply to apply the new settings to the selected fiducial and any fiducials linked 
to it. 

● Click Apply All to apply the new settings to all fiducials in the SRFF. 

If all of the fiducials are templated (linked), the Apply and Apply All buttons perform the 
same function. 

If the Apply or Apply All buttons are grayed out, then either you do not have access 
privileges based on your system login or the view does not contain a fiducial. Contact your 
system administrator if you need to access this feature. 

9. Click   to restart the inspection. 
24 SE 300 Solder Paste Inspection User Guide



Adjusting the Illumination Levels for Fiducials
Tips
● If adjusting the illumination has no effect on locating the fiducial, and the Score remains 

high, the system may be unable to distinguish between the fiducial and similar objects in 
the same field of view. In this case, use the Fiducial view to Identify a Fiducial Search Area. 
See Identifying a Fiducial Search Area on page 55.

● Make sure that the fiducial CAD data used to create the SRFF is accurately aligned with the 
actual panel. All features on the panel are located with respect to the fiducials, so if the 
fiducials are misaligned, all of the features will be offset as well. 

● You can save the image in the window as a bitmap or CCF file by clicking on  Save 
Image. CCF files are used by CyberOptics for troubleshooting purposes. 

● If you have not acquired an image ( ), then you can only save the image as a bitmap. 

See AlsoSee Also
● Fiducial Problems on page 53

● Identifying a Fiducial Search Area on page 55

● Setting Fiducial Exclusion Areas on page 56 
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Adjusting Illumination Levels for Skip Marks

Skip marks identify areas of a panel that should not be inspected. If the system cannot locate 
the skip marks as programmed, the light levels may not yield enough contrast between the 
skip mark and the surrounding material. Use the following procedure to adjust the 
illumination of the skip mark so that it is more easily seen against the background material. 

1. Before the system releases the panel, click . 

2. Open a Skip Mark View for the skip mark to examine. 

● From the Panel View, select the skip mark and then click   or 

● Drag the desired fiducial from the Panel View and drop it into an open Skip Mark View. 

3. To check the current illumination settings, click Get Image. 

4. Check the image of the fiducial and the results: 

● Score: indicates how well the fiducial read by the sensor matches the fiducial 
definition. A high score indicates a good match. 

● Confidence: is a measure of how unique the fiducial match is within the field of view. A 
high confidence value is considered good. 

● Present: indicates whether the skip mark was found (True) or not found (False). True 
means that the skip mark was found and the board is considered good. False means 
that the skip mark is not found, the board is considered bad, and the data will not be 
used. 

● NGC score: Normalized Grayscale Correlation – gauges the contrast of the skip mark 
against the background. A high value – over 60% – means that there is good contrast, 
and the skip mark is unblocked so the board is good and should be inspected. A low 
NGC value means the skip mark is blocked and the board is most likely bad; data from 
such a board would not be used. 

5. Adjust the settings as necessary: 

● Under Light Source Illumination, adjust the amount of diffuse and specular light as 
necessary. The higher the percentage, the brighter the light. 

● Under Transition, indicate whether the fiducials are lighter than the surrounding 
material (Dark-To-Light) or darker than the surrounding material (Light-To-Dark). 

6. Click Get Image to test your new settings. 

7. Continue to adjust and test your settings as necessary, until you have achieved a high score 
and high confidence level. 

8. Apply your settings in one of the following ways: 

● Click Apply to apply the new settings to the selected fiducial and any fiducials linked to 
it. 

● Click Apply All to apply the new settings to all fiducials in the SRFF. 

If all of the skip marks are templated (linked), the Apply and Apply All buttons perform 
the same function. 

If the Apply or Apply All buttons are grayed out, then either you do not have access 
privileges based on your system login or the view does not contain a fiducial. Contact your 
system administrator if you need to access this feature. 

9. Click  to restart the inspection. 
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Adjusting Illumination Levels for Skip Marks
Tips
● You can save the image in the window as a bitmap or CCF file by clicking on Save Image. 

CCF files are used by CyberOptics for troubleshooting purposes. 

● If you have not acquired an image, then you can only save the image as a bitmap. 
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Adjusting Height Calculations

The SRFF may have Z position values that were entered using Teach. Z position values specify 
a known value to remove from the inspection measurement. 

● If you choose to include Z position values and the Collect Offsets option is turned on in the 
SRFF, the Z values are added to the offset values measured during the reference scan. 

● Because of the template feature of Teach, the Z values may be set for many linked elements, 
so including the Z values may add them to the offsets for many features on the panel. 

Only select this option if you have unique pad configurations for which a reference scan will 
not correctly measure an area to be excluded, or if the SRFF is not set up to collect offsets. 

➢ To use Z values to adjust inspection heights

1. From the Tools menu, choose Options. 

2. Choose the Advanced tab. 

3. In the Inspection section, select Use SRFF Z positions to adjust inspection heights. 

4. Click OK.

➢ To set a global height offset

1. From the Tools menu, choose Options. 

2. Choose the Advanced tab. 

3. In the Inspection section, select Use SRFF Z positions to adjust inspection heights. 

4. Check the Apply to all measured height readings option and enter the global offset value 
to apply. 

5. Click OK.

i Note: Z position values and the Collect Offsets option are set in Teach.
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Generating a Whole Panel (Quilted) Image
Generating a Whole Panel (Quilted) Image

If you are using the Teach application to create a panel (SRFF) file manually, it is helpful to 
have an image of the whole panel to work with. You generate whole-panel images using the 
Scan feature in the Solder Paste Inspection application. 

1. Open a panel file. (Use the Teach application to create a basic panel file that you can open.) 

2. Click  on the toolbar. 

3. Feed a bare panel (a panel without solder paste) into the SE 300 system conveyor. 

4. The SE 300 system scans the entire panel and displays an image of the whole panel 
(sometimes called a “quilted” image) by combining individual field-of-view images taken 
by the SE 300 system's sensors. 

5. To view the whole-panel image in the Solder Paste Inspection application, open the Panel 
View. Any elements that are defined in the SRFF will appear in the right pane of the Panel 
View as geometric shapes that overlay the panel image. 

6. To open the whole-panel image in the Teach application, the folder of image files must be 
accessible from the system where Teach is installed. If necessary, copy the folder of images 
to a file server connected to the network or a CD. (The SE 300 system is equipped with a 
read/writable CD ROM.) 

Tip

The name of the image folder will be a variation of the name of the panel file you opened. For 
example, if the name of the panel file is MyPanel.srf, the name of the folder would be 
MyPanel.srf.quiltsquares. The image files in the folder end in CCF. 
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Chapter 3: Running an Inspection
Opening a Panel File

➢ Opening a file from the main window

1. Either click   or choose Open from the File menu. 

2. In the Open dialog box navigate to and select the SRFF you want to use and click Open. 

● If the system is equipped with an auto-width conveyor, a prompt appears asking you to 
confirm the conveyor width.

● If the EMO pressed, the auto-width prompt appears after the EMO is cleared.

3. Click OK to adjust the conveyor and begin the inspection.

➢ Opening a file using the handheld barcode reader

1. Make sure that the SRFF folder is identified in the Tools>Options>File Handling tab. 

2. Scan the Open SRFF File code or select Barcode Scan from the File menu. 

3. Scan the barcodes for the panel and lot number. These barcodes are provided in the work 
order.

4. Scan the Tab code to move between fields and buttons.

5. To enter the barcode data, tab to OK and scan the OK code.

6. To cancel the barcode scan, tab to Cancel and scan the OK code.

If the system is equipped with an auto-width conveyor, a prompt appears asking you to 
confirm the conveyor width.

7. Click OK to adjust the conveyor and begin the inspection.

The system opens the SRFF and may perform a reference scan. The results of the reference 
scan are displayed in the dialog bar. To run a reference scan manually, see Performing a 
Reference Scan Manually on page 33. 

i
Note: You may adjust the conveyor manually if necessary after the system automatically 
adjusts the width. If you make changes to the conveyor width, you will be prompted to save 
them when closing the panel file. 
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Performing a Reference Scan Manually
Performing a Reference Scan Manually

Typically, a reference scan is performed immediately after opening the SRFF. If failures 
occurred to prevent the reference scan from completing successfully, you can perform the 
reference scan after fixing the cause of the failure. 

During a reference scan, the system measures and stores the height of the surface of the bare 
panel. If the Collect Offsets option is set for the SRFF (using Teach), the system also measures 
the distance between the surface of the bare panel and the height of the copper and stores this 
as an offset value. Offsets are subtracted from the solder paste measurements during 
inspection to calculate actual paste height. 

1. From the Tools menu, choose Reference Scan. 

2. In the Reference Scan dialog box click Scan. 

3. Feed an unpasted panel into the SE 300 system conveyor. This must be a bare version of the 
panels you will be inspecting. 

4. Click   

The system performs a reference scan of the bare panel and puts the system in Stop mode. 
If the system cannot perform a reference scan, the Reference Scan Failure dialog box opens 
(See Reference Scan Failure on page 52). Review your scan options and click OK to 
proceed. 

5. Click   

The system enters pass-through mode and releases the panel from the SE 300 system. 

6. Remove the unpasted panel from the conveyor. 

7. When you are ready to start the inspection run with pasted panels, click .
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Selecting Skipped Boards

Use the Board Skip feature to select single or multiple boards for exclusion from inspection 
results. Once the boards are selected, the system creates a list of selected boards that the 
system checks every time the inspection begins to ensure that the selected boards are skipped. 

➢ To select skipped boards

1. Open the SRFF that you want to run.

2. Verify that the Board Image Level is set correctly for the number of root and nested images 
in the SRFF. For more information about setting the Board Image Level, refer to Changing 
the Board Image Level for Inspection Results on page 22.

3. On the View menu, click Board Skip.

The Board Skip toolbar appears.

4. Click .

5. In the panel view, click a board to skip during inspection. To select multiple boards, do one 
of the following:

● Click and drag to draw a rectangle around the boards to skip during inspection.

–or–

● Press and hold the CTRL key and click the boards. 

6. After completing board selection, click . The selected boards will be skipped during 
inspection.

7. Perform the inspection and verify that the entire panel is inspected.  Inspection results are 
not collected for the skipped boards.

i Note: To clear the selected boards, click . The previously-selected boards will no longer be 
skipped during inspection.
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Starting an Inspection
Starting an Inspection

1. Remove the unpasted panel from the conveyor (if applicable). 

2. Either click  or choose Start from the Control menu. 

When the SE 300 system receives a "Board Available" SMEMA signal from the upstream 
machine, it moves the panel into position, clamps it, and begins the inspection process. 

Tip 
● To start another run for the same panel, click  to reset the counters. 

i
Note: If system responses (such as the signal light) do not reset when the new inspection run 
begins, you need to set up an event/response to clear prior responses. See Setting Up 
Responses to System Events on page 19 for more information. 
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Using Trend Charts

Use trend charts to monitor the inspection results for consistency and to spot trends indicating 
that the measurements are drifting out of specification.

1. Click  to open a Trend Chart. 

2. In the panel view, select an element to monitor. This can be the panel, an image, a feature, 
etc. 

3. In the Trend Chart window, select the data type to monitor, such as Height. 

The Trend Chart shows a line graph of the numeric data for the current inspection of the 
selected element. The Trend chart plots up to 1000 data points, after which the oldest data is 
deleted. 

Tips
● Hold the cursor over a point on the line to display a popup window that shows the panel 

ID, the panel barcode (if known), and the measured value. 

● Click   (Numeric Report) to view the trend chart data in numeric format. 

● Once the trend chart is open, you can drag an element from the panel view into the 
window to monitor its inspection status. 

● The Offset Long and Offset Short Dimension measurements (for registration) are unsigned, 
percentage values. 
36 SE 300 Solder Paste Inspection User Guide



Stopping an Inspection
Stopping an Inspection

➢ Stopping an inspection and holding the panel

● Click . The system temporarily stops the inspection run as soon as the inspection of the 
current panel is complete. For example, you can stop the inspection if you need to 
investigate a panel failure. 

➢ Stopping an inspection and passing panels

● Either click   or choose Pass-Through from the Control menu. The system goes into 
pass-through mode, where panels pass through the system without being inspected. 

➢ To stop the SE 300 system conveyor immediately

● Press the Emergency Stop button on the front of the machine. 

For example, this may be necessary if a board is clamped improperly or if physical damage or 
injury could result if the machine is not stopped immediately. 

➢ To start an inspection after an emergency stop

1. Make sure that all panels are cleared from the conveyor. 

2. Pull out the Emergency Stop button and then press the On (green) button on the front of 
the machine. 

3. After the machine has initialized, click   in the Solder Paste Inspection application. 
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Removing a Panel from the Conveyor

1. Click 
The inspection run stops after the inspection of the current panel is complete. The 
Inspection may stop automatically when a failure occurs if the system is programmed to 
do so. 

2. Open the cover of the SE 300 system or press the Emergency Stop button.

This triggers the safety interlocks, which interrupts the power to the conveyors.

3. Pull the center conveyor section toward you, to the front of the machine.

4. Carefully remove the panel from the conveyor.

5. Close the cover of the SE 300 system.

6. Press the On (green) button located on the front of the system.

The system goes through a recovery sequence.

7. After the recovery is complete, make sure that all panels are cleared from the conveyor and 
then do one of the following:

● To resume the inspection, click   

–or–

● To switch to pass-through mode, click   

Running in Pass-Through Mode

1. Click   to stop the inspection and put the system in pass-through mode. In pass-through 
mode, panels pass through the system without being inspected.

2. Click   to restart the inspection.
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Chapter 4: Analyzing Inspection Failures
Using Defect Review

The Defect Review window contains a list of failures for the current panel and an image that 
shows where defects were found. Each time a panel is loaded, the system clears the report, so 
you must stop the system between panels to view the report for a given panel. You can have 
multiple defect review windows open at one time.

1. Either set up a stop response to inspection failures or make sure that you stop the system 
before the panel to review is released to the outbound conveyor. 

2. Click   to open Defect Review. 

If you do not stop the system, the Get Image button will not be available in the Defect 
Review window. In addition, if the SE 300 system continues to inspect, the results in the 
Defect Review window clear out as soon as the inspection for that panel is complete. For 
best results, use Teach to program the event/response properties to pause when a failure 
occurs. 

3. Select the type of data to view (Images, Locations, Features, Local Fiducials, or Image 
Fiducials) in the Data field. 

4. Select an item to review. The Defect Review window highlights the item and its 
corresponding failures.

By default, the Auto Image is turned on. This causes the system to automatically acquire a 
new image each time you select an element. You can turn off this option by clicking on . 

5. Select the type of image to view: 

● Video Image: Grayscale image of the current panel captured by the system sensor. The 
image shows the field of view that includes the selected feature 

● Height Map: Representation of height values across the entire panel. In the height map, 
light areas indicate higher paste values and dark areas indicate lower height values. 

● Modulation Index: A grayscale image that represents the validity of the height 
measurement for each pixel in the field of view. Valid pixels (shown in white) are used 
for height measurements; invalid pixels (black) are not used. 

● 3D Shaded Image: 3-dimensional, shaded image of the paste shape in the current field 
of view. Colors used in the image range from red (highest) to purple (lowest). 

If you zoom in on a feature, the view zooms to the field of view that contains the feature. If 
the feature is not scheduled for inspection, the view zooms to the parent of the selected 
feature. 

6. To save the image in the image pane as a bitmap or a CCF file, click  (CCF files are used 
by CyberOptics for troubleshooting purposes 

7. To save an image of the defect, click . A video image and height map are saved in a 
folder named DefectReview within the SRFF panel file directory. In addition, an XML file is 
created that contains failure data for the feature. 
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Using Defect Review
Tips

When you select an item, the following actions occur: 

● The system acquires a video image of the selected feature. 

● The corresponding failures are highlighted in the list of failures. 

● The item is highlighted in the image pane. 

● An arrow ( ) in the margin marks the selected item. 

● The Panel Tree in the Solder Paste Inspection Panel View expands to the selected item. 

● The navigator palette positions a cross-hair over the origin of the selected element. 

To sort defect data by a specific column, click on the column head. 

A checkmark ( ) in the left margin of the table indicates that the record was reviewed. 

You cannot save an image as CCF file until you have acquired an image using the  Get 
Image button. 

To save defect images automatically, use Teach to set up a Collect Image response to a Panel 
Failure event.

See AlsoSee Also
● Using 3D Shading View on page 43

● Viewing a Cross Section on page 44

● Viewing a Z Section on page 45
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Chapter 4: Analyzing Inspection Failures
Examining a Feature with Image View

When the system indicates that a solder-paste pad has failed, visually inspect the pad using 
the Image View. 

1. Before the system releases the panel, click   (if the system is not stopped already). 

2. Open an Image View for the pad you want to examine by doing one of the following: 

● From the Panel View, select the feature (  icon) and then click  . 

● Drag the desired feature from the Panel View or failure report view and drop it into an 
open Image View. 

3. Choose an Image Type: 

● Video Image to display a grayscale image of the current panel captured by the system 
sensor. The image shows the field of view that includes the selected feature. 

● Height Map to display a height representation for the field of view that includes the 
selected feature. In the height map, light areas indicate higher paste values and dark 
areas indicate lower height values. 

● Modulation Index to display a grayscale image that represents the validity of the height 
measurement for each pixel in the field of view. Valid pixels (shown in white) are used 
for height measurements; invalid pixels (black) are not used. 

● 3D Shaded Image to display a 3-dimensional, shaded image of the paste shape in the 
field of view. 

4. Click  Get Image. The system captures an image of the field of view that includes the 
selected feature and displays it in the window. 

5. To save the image as a bitmap or CCF file, click  Save Image. 

You can save the image as a bitmap or as a CCF file. CCF files are used by CyberOptics for 
troubleshooting purposes. If you have not acquired an image ( ), then you can only save the 
image as a bitmap.

See AlsoSee Also
● Using 3D Shading View on page 43

● Viewing a Cross Section on page 44

● Viewing a Z Section on page 45 
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Using 3D Shading View
Using 3D Shading View

Use the 3D Shading Image to see a 3-dimensional view of the shape of the solder paste within 
the field of view. The 3D Shaded Image uses a shaded perspective image and color variations 
to show the paste shape. A color key in the lower left portion of the window correlates the 
colors in the image with paste height. The color key automatically scales to the paste heights 
found in the current field of view. A transparent cube covers the selected feature showing the 
optimum paste coverage.

1. Before the system releases the panel, click  (if the system is not stopped already). 

2. Open an Image View for the pad you want to examine by doing one of the following: 

● From the Panel View, select the feature (  ) and then click .

● Drag the desired feature from the Panel View or failure report view and drop it into an 
open Image View.

3. Click  Get Image.

The 3D shaded image opens at the zoom level and position set by the other images in this 
view. For example, if you zoom in on a pad in the Height Map image and then switch to 3D 
Shaded Image, the 3D image will be zoomed in on that pad. Also, the center of the 3D 
image’s rotation will be the center of that pad.

4. Choose 3D Shaded Image from the Image Type list.

5. The tool buttons in the Tool palette do not work in the 3D Shaded Image view. In this view, 
use the trackball to control the image in the window:

Tips
● If the image is “lost” in the view, click  Get Image to capture a new image. 

● Click  Save Image to save a bitmap image of the file. 

Mouse Button 
(Click and Hold) 

Trackball 
Motion 

Effect 

Left Right Rotate clockwise 

Left Left Rotate counter-clockwise 

Left Forward Rotate in pitch angle 

Left Backward Rotate in roll angle 

Right Forward Zoom in 

Right Backward Zoom out 

Both Various Pans in the direction of the trackball 
motion 

Double-click Left n/a Turns on/off transparent cube
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Viewing a Cross Section

Use the cross-section view to show a graph of the paste heights for the selected feature. You 
can view a cross-section in either the Image View or the Defect Review window. 

1. Before the system releases the panel, click   (if the system is not stopped already). 

2. Open an Image View for the pad you want to examine by doing one of the following: 

● From the Panel View, select the feature (   icon) and then click  . 

● Drag the desired feature from the Panel View or failure report view and drop it into an 
open Image View. 

3. Click Get Image. 

4. Click  Cross Section. 

A Cross Section graph opens in the lower portion of the window. 

5. In the Image View, click and hold on a starting point for the cross section of interest. 

6. Drag the cursor across the area of interest in the Image View and then release the trackball 
button.

A white line tracks the cursor movement across the image. In the Image View: 

● The red dot on the white line indicates the starting point for the cross section 

● The blue dot indicates the ending point. 

● Right-click in the window to drag the white line to a new position. 

The Cross Section graph shows the paste heights along the white line. In the graph: 

● Green line indicates the paste height. 

● Red and blue dots correlate to the beginning and end of the cross section as drawn in 
the Image View. 

● Red dashed line indicates the average height in the field of view. 

● Purple dashed line indicates the reference plane. 
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Viewing a Z Section

Use the Z-section view to show the paste height map of a feature sectioned by a horizontal 
plane at variable heights. This view is available in either the Image View or the Defect Review 
window.

1. Before the system releases the panel, click   (if the system is not stopped already). 

2. Open an Image View for the pad you want to examine by doing one of the following: 

● From the Panel View, select the feature (   icon) and then click  . 

● Drag the desired feature from the Panel View or failure report view and drop it into an 
open Image View. 

3. Click Get Image. 

4. Click  Z Section. 

A Z Section view opens in the lower portion of the window. The right side of the Z Section 
view shows the units, the calculated area of the paste in the current view, and a range of 
height values. The selected feature is bounded by a light gray box. 

5. In the Z Section window, drag the red slider in the height box to change the height of the 
horizontal plane. The area changes to show the calculated value for the current cross 
section. 
CyberOptics Corporation 45



Chapter 4: Analyzing Inspection Failures
Entering Barcodes

When the SE 300 system internal sensor fails to read a barcode, you can use Barcode View to 
manually enter a barcode. Note that you can use Barcode View to manually correct a barcode 
only if you have set up the system to pause on barcode failures.

1. Click  to open a Panel View.

2. From the panel tree in the left pane of the Panel View, select the barcode for which you 
want to view data.

3. Click   to open Barcode View.

4. Customize the barcode view as necessary. Press the F1 key for information.

5. Select a barcode and click Get Image to display the selected barcode.

6. In the Enter box, type the barcode.

7. After typing the barcode, make sure you press Enter.

8. Click Apply.
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Checking Paste Registration

The SE 300 system measures and reports on solder paste registration, or the actual position of 
the solder paste deposits relative to the stencil aperture. Test your solder paste printer setup 
using the registration measurements on the SE 300 system. You can view registration 
measurements for individual features to focus on specific problem areas or view the overall 
registration at the panel level. 

1. Make sure that the SRFF has image-level fiducials defined. If not, use the Teach application 
to define image-level fiducials. 

2. Open the SRFF in the Solder Paste Inspection application. 

3. Load the pasted panel on the conveyor. 

4. Click   to begin the inspection. 

5. Click   to stop the system after the inspection is complete. 

6. Click   to open the Numeric Report. 

7. Drag the  Panel element into the Numeric Report. (To view feature-level measurements, 
drag the   Feature element in the report.) 

8. When the inspection finishes, analyze the registration measurements in the Numeric 
Report and adjust the printer as necessary. 

Press F1 in the Numeric Report for a description of the fields in the report. 

Tips

The SE 300 system measures the registration of each feature (or pad) and then calculates 
registration of the overall component location, image, or panel. Failures are reported under 
the following conditions:

● At the feature level for registration measurements that fall outside dimensions that are set 
up in the Teach application. The two parameters that can be set are the Long Dimension 
Offset and Short Dimension Offset.

● At the feature level for boundary violations on two sides of the feature. 

● At the location, image, and panel level when accumulations of failure counts exceed values 
set in the Teach application. 

In addition the system calculates registration data at the feature, location, image, and panel 
levels and displays it in data views for analysis. 
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Monitoring Paste Registration

Monitor trends in the printing process by viewing the registration measurements in the Trend 
Chart. Measurements that do not have tolerances set are drawn with a black line. If 
registration tolerances are set up in the Teach application, then the Trend Chart uses green and 
red to indicate whether the measurement is within specifications. Registration tolerances can 
only be set at the feature level for long and short offset values. 

1. Open the SRFF in the Solder Paste Inspection application. 

2. Click   to begin the inspection. 

3. Click   to open a Trend Chart. 

4. Drag the element of interest into the Trend Chart.

You can open multiple Trench Charts and monitor multiple elements. 

5. In the Trend Chart, select the data type to monitor, such as Rotation. 

Press F1 in the Trend Chart for a description of the measurements that can be viewed for 
each element. 

6. Analyze the data as the inspection runs. 

7. Adjust the printer as needed. 

Tips 

The SE 300 system measures the registration of each feature (or pad) and then calculates 
registration of the overall component location, image, or panel. Failures are reported under 
the following conditions: 

● At the feature level for registration measurements that fall outside dimensions that are set 
up in the Teach application. The two parameters that can be set are Long Dimension Offset 
and Short Dimension Offset. 

● At the feature level for boundary violations on two sides of the feature. 

● At the location, image, and panel level when accumulations of failure counts exceed values 
set in the Teach application. 

● In addition the system calculates registration data at the feature, location, image, and panel 
levels and displays it in data views for analysis. 
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Chapter 5: Troubleshooting
System Problems

This section describes common system problems and their solutions.

Defect Review Does Not Open Automatically

You can set events and responses so that when a failure is detected, the system stops at the end 
of the inspection, saves images of the defects, and opens Defect Review automatically.

These panel-specific events and responses must be set using Teach and saved in the SRFF. 
Refer to the Teach online help for information about how to set up events and responses for 
this type of action. 

Schedule Errors Prevent Inspection from Starting

A valid schedule file is required in order to run an inspection. The schedule file contains a 
sequence of instructions that control the SE 300 system hardware during the inspection 
process. 

Although a schedule file is always created when you open an SRFF in Solder Paste Inspection, 
schedule errors can disable the inspection Start button and may also disable the Reference 
Scan command on the Tools menu. 

When schedule errors occur: 

1. Check the Inspection Setup tab of the output palette to determine the cause of the errors. 

2. Use the Teach application to correct the SRFF. 

3. Reopen the SRFF in Solder Paste Inspection. 

i
Note: Automatic Defect Review only applies to the SE 300 Inspection application, not the 
Solder Paste Inspection application (Engineering Interface).
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Problems with Features at the Image Edge

If an SRFF for a panel with multiple boards does not contain image or component level 
fiducials, the system could place fields of view for features on the edge of one image in such a 
way as to overlap images (boards) on the panel.

If the system consistently reports inaccurate measurements for features at the edge of an 
image, stop the inspection and use Image View to view the problem area. 

1. When the inspection stops, select the feature to view and click . 

2. Determine if the field of view overlaps onto adjacent images (boards). 

3. If overlapping occurs, use Teach to create an Image-level fiducial on the image where the 
feature measurements are incorrect. The fiducial does not have to correspond to a fiducial 
on the panel and can be of any size, shape, and position. Create a task for the fiducial, but 
the fiducial does not need to be inspected.

The new fiducial causes the system to create a fiducial frame that restricts the field of view to 
the edge of the image, preventing the field of view from overlapping onto adjacent images. 

Conveyor Does Not Move
● The panel sensors may need to be adjusted: Move your hand over the panel sensors at the 

approximate height of the board. Both lights should be lit when your hand is over the 
sensors but only one light should be lit when your hand is away from the sensors. If not, 
the sensors may not be detecting when panels enter (or leave) the machine.

● SMEMA interface: The SE 300 system may be waiting for a “Board Available” SMEMA 
signal from the upstream machine: Check the upstream conveyor to make sure it is 
sending the proper SMEMA signals to the SE 300 system.

i Note: Adding a fiducial to the image could increase the number of swaths needed to inspect 
the panel, causing an increase in the overall inspection time.
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Reference Scan Failure

Reference scan failures can occur when you first open the SRFF or after you attempt to run a 
reference scan. For some reference scan failures, the system cannot perform the scan nor can 
you perform a reference scan from the Tools menu until the condition causing the failure is 
fixed. 

In some cases, you may be able to continue with the inspection, either using reference scan 
data from a previous run or using no reference scan data. The dialog box that opens for a 
reference scan failure indicates the cause of the failure and whether reference scan data exists 
for the current SRFF. 

Reference scan failures that occur when you open an SRFF can be the result of one of the 
following conditions. 

● The system cannot generate a valid reference scan schedule: Click OK to close the dialog 
box. You can either run the inspection without reference scan data or use existing reference 
scan data (if found). 

● System is not ready to run a reference scan: the system is in pass-through mode or is not 
yet initialized. Click OK to close the dialog box. When the system is initialized and ready, 
perform a reference scan by selecting Reference Scan from the Tools menu. 

Failures that appear when you attempt to run a reference scan result in the following message. 

● The system was unable to complete a reference scan: Click OK to close the dialog box. 
You can either run the inspection without reference scan data or use existing reference scan 
data (if found). 

Using Existing Reference Scan Data

The system searches for existing reference scan data for the current SRFF. If found, the data 
can be used; however, it is always best to run a new reference scan when possible. 

● Valid reference scan found: Clicking OK closes this dialog box. You can proceed with the 
inspection using the existing reference scan data. 

● Valid reference scan not found: Clicking OK closes this dialog box. You can either run the 
inspection without using reference scan data, or you can fix the cause of the failure and 
begin again. 
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Fiducial Problems

The system may not recognize fiducials on the panel for a variety of reasons. Refer to the table 
below and the related procedures for ways to identify problem fiducials.

Occasionally, an image fiducial may pass in the Fiducial View, but still fail during inspection, 
in spite of repeated attempts to make adjustments. If this occurs, your best alternative may be 
to remove the problem fiducial from the SRFF (using Teach) and then use a local fiducial as an 
image fiducial instead.

Fiducial Cross-Shapes with Rounded Corners

To further define cross-shaped fiducials, do the following:

1. On the Tools menu, click Options.

2. Click the Advanced tab.

3. Select the Cross fiducials have rounded corners check box.

4. Click OK.

Fiducial shape Fiducial Cross-Shapes with Rounded Corners on page 53

Fiducial lighting Adjusting the Illumination Levels for Fiducials on page 54

Hot-air-solder-leveled (HASL) 
surfaces

Setting Fiducial Exclusion Areas on page 56
CyberOptics Corporation 53



Chapter 5: Troubleshooting
Adjusting the Illumination Levels for Fiducials

Fiducials are used as reference points for the panel inspection. If the system cannot locate the 
fiducials, the panel cannot be inspected. The system may not be able to locate a fiducial if the 
light levels do not yield enough contrast between the fiducials and the surrounding material. 
Use the following procedure to adjust the illumination of the fiducial so that it is more easily 
seen against the background material. 

1. Before the system releases the panel, click . 

2. Open a Fiducial View for the fiducial you want to examine. If you want to adjust the 
illumination levels for all fiducials on the panel, select any fiducial. 

● From the Panel View, select the fiducial (  icon) and then click   

or 

● Drag the desired fiducial (  icon) from the Panel View and drop it into an open 
Fiducial View. 

3. To check the current illumination settings, click  Get Image. 

4. Check the image of the fiducial and the results: 

● Score: indicates how well the fiducial read by the sensor matches the fiducial 
definition. A high score indicates a good match. 

● Confidence: is a measure of how unique the fiducial match is within the field of view. A 
high confidence value is considered good. 

● Pass/Fail indicates whether the system will be able to find the fiducials with the current 
settings (Pass) or not (Fail). 

5. Adjust the settings as necessary: 

● Under Light Source Illumination, adjust the amount of diffuse and specular light as 
necessary. The higher the percentage, the brighter the light. 

● Under Transition, indicate whether the fiducials are lighter than the surrounding 
material (Dark-To-Light) or darker than the surrounding material (Light-To-Dark). 

6. Click  Get Image to test your new settings. 

7. Continue to adjust and test your settings, as necessary, until you have achieved a high 
score and high confidence level. 

8. Apply your settings in one of the following ways: 

● Click Apply to apply the new settings to the selected fiducial and any fiducials linked 
to it. 

● Click Apply All to apply the new settings to all fiducials in the SRFF. 

If all of the fiducials are templated (linked), the Apply and Apply All buttons perform the 
same function. 

If the Apply or Apply All buttons are grayed out, then either you do not have access 
privileges based on your system login or the view does not contain a fiducial. Contact your 
system administrator if you need to access this feature. 

9. Click  to restart the inspection. 
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Tips
● If adjusting the illumination has no effect on locating the fiducial, and the Score remains 

high, the system may be unable to distinguish between the fiducial and similar objects in 
the same field of view. In this case, use the Fiducial view to identify a fiducial search area.

● Make sure that the fiducial CAD data used to create the SRFF is accurately aligned with the 
actual panel. All features on the panel are located with respect to the fiducials, so if the 
fiducials are misaligned, all of the features will be offset as well. 

● You can save the image in the window as a bitmap or CCF file by clicking on  Save 
Image. CCF files are used by CyberOptics for troubleshooting purposes. 

● If you have not acquired an image ( ), then you can only save the image as a bitmap. 

Identifying a Fiducial Search Area

Fiducials may fail when the system is having trouble distinguishing between an image 
fiducial and similar objects in the same field of view. Use this procedure to specify the area in 
which to search for a fiducial when the system cannot locate the fiducial on a panel. 

1. Open a Fiducial View for the fiducial you want to examine. 

2. Click  Get Image. 

3. Click  Locate. 

The cursor changes to the  symbol surrounded by a gray bounding box. 

4. Move the bounding box over the fiducial in the image. 

5. Click the left mouse button to select the area as the search area for the fiducial. 

The system creates an new, temporary inspection schedule that includes this search area. 

6. Click  Apply. 

The bounding box changes to orange and the inspection schedule is rewritten. You can 
now re-run the panel inspection with the new fiducial information. 

Tips
● After inspection is complete on the current panel, the fiducial position reverts back to the 

coordinates specified in the SRFF. Changes made to the fiducial inspection area are used 
only on the current panel and are not saved. 

● Click  Clear to cancel the search area changes. If you have applied the search area 
changes, make sure that you click   Clear and then   Apply. 

● Pressing the EMO button or breaking a safety interlock (such as lifting the SE 300 system 
top cover) clears the search area from the fiducial view. 

● If the fiducial is still not found, try removing the problem fiducial from the SRFF (using 
Teach) and then using a local fiducial as an image fiducial instead. 
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Setting Fiducial Exclusion Areas

Irregularities on the surface of the fiducial prevent the system from finding the fiducial. For 
example, hot-air-solder-leveled (HASL) finishes may create irregularities in the finish in the 
center of the fiducial. The irregular surface causes light to be reflected in ways that distort its 
shape, causing the system either to be unable to find the fiducial or to find it, but position it 
incorrectly. 

Use this procedure to mask areas of a fiducial that prevent the system from locating it 
properly. 

1. Open a Fiducial View for the fiducial you want to examine. 

2. Enter a value in the Exclude Center% box that describes the area to exclude from 
inspection. 

3. Click  Apply. 

The system creates an area in the same shape as the current fiducial task and of the size 
specified. In the fiducial view, the excluded area is marked by a blue dashed line. Everything 
inside the line will be excluded from inspection. 
56 SE 300 Solder Paste Inspection User Guide



Error Messages
Error Messages

The output palette displays messages about system operation, including error messages when 
problem are encountered. Error messages are displayed in each related tab:

● Data Handling Error Messages on page 58

● Inspection Setup Error Messages on page 59

● Logon Error Messages on page 62 

● SRFF Error Messages on page 63

● System Error Messages on page 64
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Data Handling Error Messages

The Data Handling tab of the Output Palette opens automatically to show the results from 
creating CSV and XML data files. The system clears this tab each time you open an SRFF. 

XML/XSLT parse error

Parse Error in [filename] at line [x] [reason] 

The system could not load the XML or XSLT file. The error message specifies the filename, line 
number and reason for the error. Open the file specified, correct the problem and save the file. 

XML/XSLT error

Transform Failed on [filename] 

System could not perform the transform specified in the XSLT file. Review the specified file 
for errors.

[time][filename] Open Failed 

The named file could not be opened. It may have been removed from the path selected by the 
Browse button. Go to the Solder Paste Inspection Options dialog box, File Handling tab and 
use the Browse button to navigate to the XSLT file.

Failed to instantiate an XML DOM 

Internal XML problem; the SE 300 system cannot generate an XML data file. No CSV or SML 
data can be output.

No XSL (or CSV) Output

The file specified was not found. Typically a system problem occurred that prevented the 
created of the output file.

XML DOM template created in __seconds 

Status message showing how much time the system took to create the XML file.

Terms

CSV Comma Separated Value: a data file format in which the values listed in the file are 
separated by commas 

DOM Document Object Model 

XML  Extensible Markup Language 

XSL Extensible Stylesheet Language 

XSLT XSL Transformation 
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Inspection Setup Error Messages

The Inspection Setup tab of the Output palette shows the results from creating a Schedule File 
from the SRFF, errors found when creating a fiducial template, and the speed at which fiducial 
definition files were created. The system clears this tab each time you open an SRFF. 

Viewing Inspection Setup Messages

The Output palette opens automatically with the Inspection Setup tab on top when a schedule 
error occurs or when an error occurs when creating a fiducial template. 

Schedule errors can occur when you are attempting to either run an inspection or perform a 
reference scan. Even if no errors occur, you can still view the latest schedule results by viewing 
the Schedule tab of the Output palette. 

VS Find errors can occur when the system cannot read the fiducial definition from the SRFF. 

The same schedule output is also written to a file called ScheduleLog.txt in the folder where 
the Solder Paste Inspection application is installed. You can view this file directly by opening 
it with a text editor, such as Windows Notepad. 

VS Find errors are not written to the schedulelog.txt file 

Error Messages

Inspection Setup errors are usually due to missing or invalid information in the SRFF. Use the 
error messages to help determine the causes of the errors, and then update the SRFF 
accordingly (using Teach). 

The path of the feature or fiducial appears as:

Panel 0 | Board 1 | R12 | Pad 1 

A schedule file is always written, but errors reduce the number of features and fiducials 
scheduled. 

An error found in a templated panel element will generate an error for each instance of the 
element. Correcting one instance will correct all templated instances. 

Types of error messages include:

Unschedulable Fiducial

These errors can be caused by the following types of problems: 

● No Illumination: The task associated with the fiducial does not have sensor-illumination 
values set up for it. 

● No Geometry: The task associated with the fiducial does not have an inspection area 
with a defined model/geometry, and the task itself does not have a defined model/
geometry. At least one of these conditions must be met. When both are met, the 
inspection-area model is used. 

● Invalid Box: The bounding box described by the model/geometry is not valid. 
CyberOptics Corporation 59



Chapter 5: Troubleshooting
● Inspection Area's X Dimension < 16 mm: If the inspection area’s model/geometry is 
used, the size of the X dimension of its bounding box must be at least 16 mm. Keep in 
mind that the maximum allowable X dimension to fit in a field of view is 20 mm. If the 
inspection area’s model is not defined and the task model is defined, the search area 
defaults to the full field of view (10 mm by 20 mm). 

Unschedulable Feature

There are two types of unschedulable-feature errors—inspection and reference scan. The 
following are some possible causes of inspection-related errors: 

● No Solder Paste: The task associated with the feature does not have solder-paste 
tolerances set up for it. 

● No Inspection Geometry: The task associated with the feature does not have an 
inspection area defined with a model/geometry. 

● Invalid Box: The bounding box described by the model/geometry is not valid. 

The following are some possible causes of reference-scan errors: 

● No Model Geometry: The task associated with the feature does not have a model/
geometry defined. 

● Invalid Reference Box: The bounding box described by the model/geometry is not 
valid. 

Dimension Error

The dimension of the bounding box of the object cannot fit within a swath or field of view. 
Dimension error messages include the feature’s bounding box dimensions, which are 
given in the following format: 

(MinX, MinY) (MaxX, MaxY) 

Check the values and adjust them as necessary. Note that a full field of view is 10 mm by 20 
mm. 

Position Error

Position errors result when the placement of an object is beyond the bounds of the panel or 
the machine’s limits. Position error messages include the position requested followed by 
the maximum position in the given dimension. 

There are two types of position errors: 

● Max X Position Beyond Machine Capabilities 

● Max Y Position Beyond Machine Capabilities 

VsFind Error

VsFind errors result when the system cannot read the fiducial definition from the SRFF. 
Use Teach to open the SRFF and review the fiducial setup. 
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Summary Information

The summary information at the end of the output lists the number of errors that occurred and 
a summary of the schedule results. 

Total Fiducials and Features 

These are the total numbers of fiducials and features in the SRFF. 

Schedulable Fiducials and Features 

If the number of schedulable fiducials or features is less than the total number of fiducials 
and features, it could be because: 

● The task associated with a fiducial or feature is not set to Inspect. 

● An “unschedulable” type of error occurred. 

Scheduled Features 

The number of features actually scheduled after subtracting any features with dimension 
or position errors from the number of schedulable features. 

Scheduled Fiducial Frames 

This reflects the grouping of features into areas that are related to one or more fiducials. 
Even without a fiducial, there is always a panel-level frame. Beyond that, the frames are 
based on image and local fiducials. 

Fiducial definition files created in __seconds

Status message indicating how much time the system took to create fiducial definitions 
based on the SRFF. 
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Logon Error Messages

The Security tab of the Output palette opens automatically to show the results of login 
attempts on the system. The messages in this tab are retained until you shut down system 
power. Logon errors can be either username and password conflicts or security file errors. 

Username and Password Conflicts

A valid username and password is required for access to the Solder Paste Inspection 
application. If either the username or password entered are not valid, access to the system is 
denied. Re-enter the username and password.

Security File Errors

Security file errors typically mean that the security file (SE300.sec) is corrupt or contains 
errors. When the security file cannot be read, the SE 300 system returns to the default security 
assignments. If you have Supervisor rights, you can reset the Security Assignments using the 
Security menu. Any changes are saved and the security file is overwritten when you click OK 
in the Security Assignments dialog box.

The error messages that may appear are:

● Unrecognized signature: The file header signature indicates that the file is not in the 
correct format or is otherwise corrupted.

● Mismatch in the Header, Index, or Data block: The file has been corrupted since it was last 
written.

● Version mismatch: The file contains the wrong version of information.

● Does not contain data: The security file (SE300.sec) does not apply to, or does not contain 
information for, the application currently running.
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SRFF Error Messages 

When you open an SRFF, the Solder Paste Inspection application checks the file to make sure 
its contents are valid. If the system detects errors, the application displays the results on the 
SRFF tab of the Output Palette. It also writes the results to a file called srflog.txt in the SE 300 
system Software folder. The system clears this tab each time you open an SRFF. 

SRFF Error Message Format

Each SRFF error or warning message includes the following information: 

● The error code (for example, ERROR 5101). 

● The line number in the SRFF where the error was detected. 

● The name of the token (or field) for which the error was detected. No token is specified for 
errors in LIST or SELECT statements. 

● The type of error (for example, “Unknown Schema Entry”). 

In some cases, an error message may point to a line in the Data section of the SRFF, but the 
problem may actually be in the Schema section.

Correcting Errors

You can use a text editor to correct the SRFF, but it is much more reliable to use the Teach 
application to correct the problems identified in the SRFF tab. 
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System Error Messages

The System tab on the Output palette displays any hardware-related messages and errors 
resulting from copying or clearing system files. These messages may help you troubleshoot 
problems related to the hardware or the internal software. The messages in this tab are 
retained until you shut down system power. 

System Error Message Format

System messages are displayed in the following format: 

<date> <time> <xyz> <text-message> 

where <xyz> is a 3-digit error code and <text-message> describes the nature of the error. 
When reporting these types of errors to CyberOptics, be sure to make a note of any error codes 
displayed. 

Example: 

04-Mar-2003 09:26:20 510 StopRun communications failed (StopRun) 

Error Code Format (<xyz>) 

The error codes are intended for use primarily by CyberOptics personnel to troubleshoot 
internal system related errors, but a basic understanding of the error code format can give you 
clues about the severity of the error and the source of the problem. 

First digit (x): Disposition 

The first digit indicates the severity of the error and gives you an idea of what you should do 
about it, if anything. 

1. Notice A minor problem occurred, but the system continued to operate without 
interruption

2. Warning A moderate problem occurred, but the system continued to operate 
without interruption. Warnings may be written to the system log. 
Examples of problems that may trigger warnings: 
Fiducial alignment out of tolerance 
Dark images 
System resources nearly overrun 
Data corruption in non-critical data

Reserved (not used) Reserved (not used) 
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Error Messages
Second digit (y): Classification

The second digit identifies the apparent source of the error, as detected by the SE 300 system. 

Third digit (z): Specific Error

The third digit identifies the specific error and generally corresponds to the accompanying 
text message. 

4. Transient error An action cannot be performed due to a temporary bottleneck or 
correctable problem. The system will generally retry an action when a 
transient error occurs. Examples of transient errors: 
Communication timeout 
Disk or queue full 
Timeout waiting on sensor data

5. User or system 
intervention

Something that should have worked failed for unknown reasons. The 
operator must restart the system to clear the error, unless the system 
restarts itself. Examples of problems that may require intervention: 
Hardware communications failed 
Motion stalled 
An action was retried but was still unsuccessful

6. Permanent error A serious program error occurred that requires that you restart the 
system. Report these types of errors to CyberOptics. Examples of 
permanent errors: 
Schedule file errors 
Data corruption in critical data 
Non-existent feature

Reserved (not used) Reserved (not used) 

0 Syntax or parameter error 

1 Communication error 

2 File system error 

3 Image processing error 

4 Sensor error 

5 Motion error 

6 Conveyor error 

7 Operating system error 

8 Reserved (not used) 

9 Other 
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Chapter 6: Inspection Results CSV Output Data
Feature-Level Data

When you select feature-level data for CSV output, the following inspection results are saved 
in the file. Data in the Detail column is saved only when the Use Detailed Format option is 
selected. See the Glossary for a description of each column heading.

Data Standard Detail 

ID Information 

Date/Time

Panel ID

Board

Location

Feature

Overall Status

Status

H/A/V Measurements and Tolerances 

Height Result 

Height 

Height Upper Failure

Height Lower Failure 

Height Target

Area Result

Area

Area Upper Failure

Area Lower Failure

Area Target 

Volume Result

Volume

Volume Upper Failure

Volume Lower Failure

Volume Target

Registration Measurements and Results 

Valid

Registration Result

X Offset

Y Offset 
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Feature-Level Data
Registration Short %

Registration Long %

Registration Short % Failure 

Registration Long % Failure

Bridge Measurements and Results 

Bridge Result/TD 

Bridge Length

Bridge Failure 

Data Standard Detail 
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Image-Level Data 

When you select image-level data for CSV output, the following inspection results are saved 
in the data file. Data in the Detail column is saved only when the Use Detailed Format option 
is selected. See the Glossary for a description of each column heading.

Data Standard Detail 

ID Information 

Date/Time

Panel ID

Board

Overall Status

Status

Registration Measurements

X Offset (Offset X)

Y Offset (OFfset Y)

Rotation 

Scaling 

HAV Failure Counts and Tolerances

HAV Failed Feature Result

HAV Failed Features

HAV Failed Features Max

HAV Failed Location Result

HAV Failed Locations

HAV Failed Locations Max

Registration Failure Counts and Tolerances

Reg Failed Features Result

Reg Failed Features

Reg Failed Features Max

Reg Failed Locations Result

Reg Failed Locations

Reg Failed Locations Max

 Bridging Failure Counts and Tolerances 

Bridge Failed Features Result

Bridge Failed Features
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Image-Level Data 
Bridge Failed Features Max

Bridge Failed Locations Result

Bridge Failed Locations

Bridge Failed Locations Max

Data Standard Detail 
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Location-Level Data 

When you select location-level data for CSV output, the following inspection results are saved 
in the data file. Data in the Detail column is saved only when the Use Detailed Format option 
is selected. See the Glossary for a description of each column heading.

Data Standard Detail

ID Information 

Date/Time

Panel ID

Board

Location

Part

Package

Overall Status 

Status

 H/A/V Measurements and Tolerances 

Height Avg Result

Height Average

Height Average Upper Failure

Height Average Lower Failure

Height Average Target

Height Range Result

Height Range

Height Range Max

Area Result

Average Area

Area Upper Failure

Area Target

Area Range Result

Area Range

Area Range Max

Volume Result

Average Volume

Volume Upper Failure

Volume Lower Failure 

Volume Target
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Location-Level Data 
Volume Range Result

Volume Range

Volume Range Max

Registration Measurements 

X Offset

Y Offset

Rotation

Scaling

HAV Failure Counts 

HAV Failed Feature Result

HAV Failed Features

HAV Failed Features Max 

Registration Measurement and Tolerances 

Reg Failed Feature Result

Reg Failed Features

Reg Failed Features Max

Bridge Measurement and Tolerances 

Bridge Failed Feature Result 

Bridge Failed Features

Bridge Failed Features Max

Data Standard Detail
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Chapter 6: Inspection Results CSV Output Data
Panel-Level Data 

When you select panel-level data, the following inspection results are saved in the data file. 
Data in the Detail column is saved only when the Use Detailed Format option is selected. See 
the Glossary for a description of each column heading. 

Standard Detail 

ID Information 

Date/Time

Panel ID

Overall Status

Status 

Registration Measurements 

X Offset

Y Offset

Rotation 

Scaling

HAV Failure Counts and Tolerances 

HAV Failed Feature Result

HAV Failed Features 

HAV Failed Features Max

HAV Failed Location Result 

HAV Failed Locations 

HAV Failed Locations Max 

HAV Failed Images Result 

HAV Failed Images 

HAV Failed Images Max

Registration Failure Counts and Tolerances 

Reg Failed Features Result

Reg Failed Features 

Reg Failed Features Max 

Reg Failed Locations Result 

Reg Failed Locations 

Reg Failed Locations Max

Reg Failed Images Result

Reg Failed Images
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Panel-Level Data 
Reg Failed Images Max

Bridging Failure Counts and Tolerances 

Bridge Failed Features Result

Bridge Failed Features

Bridge Failed Features Max

Bridge Failed Locations Result 

Bridge Failed Locations

Bridge Failed Locations Max

Bridge Failed Images Result

Bridge Failed Images

Bridge Failed Images Max
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Chapter 7: For More Information
Technical Support

If you have problems operating the SE 300 system, first check the product documentation for 
more information.

If you still need help with the SE 300 system, or you discover problems with documentation, 
telephone, e-mail, or fax CyberOptics Service and Support.

● Include your serial numbers in all e-mail messages and faxes.

● Have the product serial numbers ready when you telephone CyberOptics.

North America 
CyberOptics Corporation
Minneapolis, Minnesota USA
800 526 2540, or +1 763 542 5000

Asia-Pacific
CyberOptics Singapore, Ltd.
Singapore
+65 6744 3021

Europe
CyberOptics Ltd.
United Kingdom
+44 (0) 1756 700 330
Fax +1 763 542 5100 (Attn: Service) 

Website http://www.cyberoptics.com

Email service@cyberoptics.com

CyberOptics® Corporation
5900 Golden Hills Drive
Minneapolis, Minnesota 55416 USA
USA +1 763 542 5000 
USA FAX +1 763 542 5100

Visit our home page on the Web:
http://www.cyberoptics.com

E-mail:
info@cyberoptics.com
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Copyright and Terms of Use
Copyright and Terms of Use

CYBEROPTICS DISCLAIMS LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING FROM THE USE OR MISUSE OF ANY OF ITS PRODUCTS. THE 
CUSTOMER IS RESPONSIBLE FOR ANY OPERATION OF THIS PRODUCT NOT 
RECOMMENDED BY THIS DOCUMENTATION.

Information in this document is subject to change without notice. CyberOptics Corporation 
may make improvements or changes in the products described in this publication at any time.

CyberOptics is a registered trademark in the United States owned by CyberOptics 
Corporation and registered in the U.S. and other countries.

© 2008 CyberOptics Corporation. All Rights Reserved.
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Chapter : Glossary
A

Area

The area of a given feature as measured by the system. Area measurements are given in square 
units. 

Area Range 

Difference between the largest and smallest areas measured for the features of a given 
location. 

Auto Mode

When selected, the system automatically acquires an image each time you select a new object 
in the failure report or image view. This eliminates the need click on the Get Image button 
after selecting a new object. 

Average Area 

The average area of the features for a given location as measured by the system. 

Average Height 

The average height of the features for a given location as measured by the system. 

Average Volume 

The average volume of the features for a given location as measured by the system. 

B

Barcode

A special machine-readable code, represented as a sequence of long, narrow bars, that 
identifies a given panel. 

Bridge Failure

The limit for the bridge length measurement. If a measurement exceeds this limit, it is 
considered a failure. 

Bridge Length 

Sum of the lengths of all places where the solder paste intersects the feature inspection area for 
the feature. 

Boundary Violation

See Registration Status. 

Bounding Box 

In the Display Options dialog box, check this box to display the boundaries of each element. 
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C

Comment

For feature-level registration failures, the comment field states whether a measurement was 
valid and whether a boundary violation occurred. If a boundary violation has occurred, this 
field specifies whether the violation exists on one side only or on opposing sides. Features 
with boundary violations are not used to calculate registration results and the location, image, 
and panel level.

Component Definition (Part) 

Describes the component by type and/or functionality. A component definition is often 
identified by a part number. 

Component Link 

Associates a component definition (part) with a standard package description that contains 
information such as the part dimensions. A component link is often identified by the package 
type. 

Confidence 

The confidence value indicates the level of certainty (compared to other shapes found in the 
field of view) that it has found the fiducial or skip mark. A high confidence value is 
considered good. Data is displayed for fiducials and skip marks only.

D

Date/Time 

The date and time that a row of data was collected. 

Delta 

Delta is the difference between the actual measurement and the tolerance. 

Difference 

Difference is the difference between the actual measurement and the tolerance.

Diffuse

Light projected directly at the object from above. 

E

F

Failed Features 

The total number of features that have failed on the current panel. 

Failed Features Bridging 

The number of features on the panel, image, or location that have bridging failures. 
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Failed Features Registration 

The number of features on the panel, image, or location that failed registration measurements. 

Failed Locations Bridging 

The number of locations on the panel or image that have bridging failures. 

Failed Locations Registration 

The number of locations on the panel or image that failed registration measurements. 

Failed Features H/A/V

The number of features on the panel, image, or location that failed solder paste dimension 
measurements (Height, Area, or Volume). 

Failed Images Bridging 

The number of images on the panel that have bridging failures. 

Failed Images H/A/V 

The number of images on the panel that failed solder paste dimension measurements (Height, 
Area, or Volume).

Failed Images Registration

The number of images on the panel that failed registration measurements. 

Failed Locations 

The total number of locations (components) that have failed on the current panel.

Failed Locations H/A/V 

The number of locations on the panel or image that failed solder paste dimension 
measurements (Height, Area, or Volume). 

Failure Type 

The type of measurement that was outside the specifications such as height, area, volume, 
registration, or bridging. 

● Height, area, and volume failures indicate whether the measurement was too high or 
too low. 

● Feature registration failures may include short offset failures, long offset failures, and 
boundary violations. 

● Solder bridge failures are indicated by the Bridge Length measurement displayed in the 
units of the SRFF. 

● Failure counts that exceed preset maximum values are recorded by element (panel, 
image, or location) and by measurement type (H/A/V, Registration, or Bridge). 
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Feature

A specific object on the panel described by its position and orientation. A feature is the 
individual item from which a measurement is taken or on which an inspection is performed. 
For example, individual pads in a pattern, such as pin 1, pin 2, etc., are features. 

Feature Failures 

The number of features on the selected panel, image, or location that contained failures. 

Fiducial 

A feature used as a point of reference for specifying positions on a panel. 

● An Image Fiducial is associated with an overall printed-circuit board. 

● A Local Fiducial is associated with a location (component). 

G

H

Height 

The height of a given feature as measured by the system. The units of measurement are shown 
in the lower right corner of the Solder Paste Inspection window. 

Height Range

The difference between the maximum and minimum heights that the system has measured for 
the features of a given location. The units of measurement are shown in the lower right corner 
of the Solder Paste Inspection window.

Height Map 

Representation of height values across the entire panel. In the height map, light areas indicate 
higher paste values and dark areas indicate lower height values. 

I

Image 

An individual board on a panel described by its position and orientation. 

Image Definition 

Describes a group of locations (components). Also could define the criteria used to determine 
when an image (board) has failed, such as a number of location or feature failures.

Image Failures

The number of failed images on the selected panel. 

Initializing

The system is going through a start-up process in preparation for an inspection. 
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Invalid

The system was unable to run a valid reference scan nor has it located valid reference scan 
data.

Item 

The Item identifies the element for which a given failure was detected (panel, image, location, 
feature, or fiducial).

J

Jack 

In the Display Options dialog box, check this box to display an element's central axis. The 
orientation of the jack shows the degree to which the element is rotated.

K

L

Level 

Indicates whether the data applies to the Panel (P), Image (I), or Location (L). 

Locate 

Use the Locate tool to manually identify an inspection area in the fiducial view. You must first 
click  Get Image to acquire an image of the panel.

Location 

A specific component on the panel described by its position and orientation. Locations are 
often identified by their reference designator, such as U44.

Location Failures

The number of failed locations on the selected panel or image. 

Long Dimension Offset

Registration measurement that describes the shift measured in the direction of the longest side 
of the feature. The value is an unsigned number and is expressed as a percentage of the long 
side dimension. This measurement is only made on features, and is one of two registration 
measurements for which tolerances can be set.

Lower Failure

The lower limit for a given measurement. If a measurement falls below this limit, it is 
considered a failure. 
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Lower Limit
● If the trend chart represents the height, volume, or area of pads, this is the lower limit of 

the tolerance for the measurement. If a measurement is below this value, it is 
considered a failure. 

● For all other data, the lower limit is 0. 

M

Max Fail

The number of failures allowed before flagging a location, image, or panel
failure.

Measurement

The actual measurement taken by the system. 

Modulation Index

A grayscale image that represents the validity of the height measurement for each pixel in the 
field of view. Valid pixels (shown in white) are used for height measurements; invalid pixels 
(black) are not used. 

N

Name

In the Display Options, check this box to display the names of the elements used to define a 
given panel. The names are taken from the panel (SRFF) file.

NGC Score

Normalized Grayscale correlation: This value gauges the contrast of the skip mark against the 
background. A high value – over 60% – means that there is good contrast, and the skip mark is 
unblocked so the board is good and should be inspected. A low NGC value means the skip 
mark is blocked and the board is most likely bad; data from such a board would not be used. 
Adjusting the illumination can bring the contrast of a borderline skip mark into a higher 
range.

Nominal Value
● If the trend chart represents the height, volume, or area of features (e.g., pads), this is 

the target value for a given measurement. 

● For all other data, the nominal value is not significant. 

O

Offset

As used in the context of reference planes, the difference between the height of the reference 
plane of the panel and the height of the copper. The offset value is subtracted from the paste 
measurement so that the result reflects only solder paste. 
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Offset Long Dim

Registration measurement that describes the shift measured in the direction of the longest side 
of the feature. The value is an unsigned number and is expressed as a percentage of the long 
side dimension. This measurement is only made on features, and is one of two registration 
measurements for which tolerances can be set. 

Offset Short Dim

Registration measurement that describes the shift measured in the direction of the shortest 
side of the feature. The value is an unsigned number and is expressed as a percentage of the 
short side dimension. This measurement is only made on features, and is one of two 
registration measurements for which tolerances can be set. 

Offset X

Amount of shift in registration across the feature, location, image, or panel measured in the X 
or horizontal direction. For features, this value represents individual measurements on the 
feature. For locations, images, and panels, this value is calculated from the feature-level 
measurements. Positive values indicate a shift to the right, negative values indicate a shift to 
the left. Tolerances cannot be set for this value. 

Offset Y

Amount of shift in registration across the feature location, image, or panel measured in the Y 
or vertical direction. For features, this value represents individual measurements on the 
feature. For locations, images, and panels, this value is calculated from the feature-level 
measurements. Positive values indicate an upward shift, negative values indicate a 
downward shift. Tolerances cannot be set for this value.

P

Package

Package type (component link) that correlates to the failed location. 

Panel Description

The top-level element used to store properties that apply to the panel as a whole, such as panel 
dimensions and measurement events and responses.

Panel ID

This identifies the panel to which this inspection data applies. It is either the panel's barcode, if 
there is one, or a sequential number the system assigned to the panel. 

Panel Flow

Indicates the direction in which panels flow through the system: 

● Left to Right: Panels enter the system from the left and exit the system on the right. 

● Right to Left: Panels enter the system from the right and exit the system on the left. 

Panels Failed

The number of panels that have failed inspection based on the inspection criteria.
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Panels Inspected 

The number of panels that the system has inspected so far.

Panels Passed

The number of panels that passed inspection based on the inspection criteria.

Part

Part number (component definition) that correlates to the failed location.

Pass-Through

The system is passing panels through the system without inspecting them. This occurs when 
you click  or choose Pass-Through from the Control menu.

Pattern Definition

Describes a group of features including the number of leads and the location of pin 1. May 
also define the criteria used to determine when a component has failed. A pattern definition 
often describes the land pattern, such as QFP64.

Present

Indicates whether the skip mark was found (True) or not found (False). True means that the 
skip mark was found and the board is considered good. False means that the skip mark is not 
found, the board is considered bad, and the data will not be used.

Process

In the Display Options dialog box, check this box to show the properties of elements that 
correspond to actions to be performed. For example, tasks can define the boundaries of areas 
where pads are inspected. If you select Process, the geometry of the elements appears in dark 
red before they are inspected. After they are inspected, they appear as green if they pass 
inspection and bright red if they fail inspection.

Product

In the Display Options dialog box, check this box to show the properties of elements that 
correspond to their physical characteristics. For example, pads have shapes. If you select 
Product, the geometry of the elements appears in dark blue.

Q

Quilted Image

Scanned image of the panel created by stitching fields of view together into one image.

R

Range Max

The tolerance value set for overall range measurements. When the range exceeds this value, a 
failure is flagged.
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Ready 

The system is initialized and ready for you start an inspection or perform some other action. 

Reference Scan

During a reference scan, the system measures and stores the height of the surface of the bare 
panel to be used as a baseline for paste measurements.

Registration Long Percentage

The registration measurement expressed as a percentage of the pad’s longer dimension. 

Registration Long Percentage Failure

The limit for the registration measurement in the pad’s longer dimension. If the measurement 
exceeds this limit, it is considered a failure.

Registration Short Percentage

The registration measurement expressed as a percentage of the pad’s shorter dimension. 

Registration Short Percentage Failure

The limit for the registration measurement in the pad’s shorter dimension. If the measurement 
exceeds this limit, it is considered a failure.

Registration Status

Indicates the validity of the feature’s registration measurement with respect to boundary 
violations. A boundary violation occurs when solder paste extends beyond the measurement 
area. Features with boundary violations are not used in the calculations for overall registration 
measurements. Features with boundary violations on two sides will cause a feature failure. 

● Valid: Registration measurement is valid with no boundary violations. 

● Violation on One Side: A boundary violation occurred between the paste and the 
measurement area on one side of the measurement area.

● Violation on Opposing Sides: A boundary violation occurred between the paste and 
the measurement area on two opposing sides of the measurement area. This condition 
causes a feature failure. 

Data is displayed for features only. 

Result

Indicates whether the specific measurement type passed (P) or failed (F) inspection, based on 
the measurements and tolerance values. The result column only appears in detailed log files 
(detail option selected). 

Rotation

Amount of skew across the location, image, or panel. This value is calculated from feature-
level measurements and is expressed in the angle units of the SRFF such as degrees. Positive 
values indicate a counter-clockwise shift, negative values indicate a clockwise shift. Tolerances 
cannot be set for this value. This data is used in troubleshooting registration problems. 
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S

Save Image

Saves the image that appears in the image view portion of the window. You can save the 
image as a bitmap or as a CCF file. CCF files are used by CyberOptics for troubleshooting 
purposes. If you have not acquired an image ( ), then you can only save the image as a 
bitmap. 

Scaling 

Amount of stretch in registration across the location, image, or panel. This value is calculated 
from feature-level measurements and is expressed as a percentage of the horizontal 
dimension. Positive values indicate an increased dimension, negative values indicate a 
decreased dimension. Tolerances cannot be set for this value. This data is used in 
troubleshooting registration problems. 

Scheduled Fields of View 

The total number of fields of view specified in the schedule. 

Scheduled Swaths 

The total number of passes specified in the schedule. 

Schedule File

The schedule file contains a sequence of instructions that control the SE 300 system hardware 
during the inspection process. A valid schedule file is required in order to run an inspection. 

Score 

The Score value indicates how well the fiducial or skip mark read by the sensor matches the 
definition. A high score indicates a good match. Data is displayed for fiducials or skip marks 
only. 

Shape 

Describes the footprint of a feature, fiducial, or skip mark. Shape size should correspond to the 
stencil aperture data for the feature. Shape options are disc, donut, cross, rectangle, diamond, 
and triangle. 

Short Dimension Offset

Registration measurement that describes the shift measured in the direction of the shortest 
side of the feature. The value is an unsigned number and is expressed as a percentage of the 
short side dimension. This measurement is only made on features, and is one of two 
registration measurements for which tolerances can be set.

Skip Mark

A feature on a panel that indicates to inspection and placement machines that a given element 
(usually a board or image) is present or absent. A skip mark may indicate that a board is faulty 
and should not be populated with components.
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Specular 

Angled light that illuminates the background. 

Status 

Indicates whether the element passed (P) or failed (F) inspection, based on measurements and 
tolerances. The status column only appears in standard log files (detail option not selected).

T

Target 

The nominal value set for a given measurement. 

Task 

Defines the dimensions of an inspection area, as well as the inspection criteria. 

Time Remaining 

The estimated amount of time it will take to complete the inspection of the current panel. 

Time/Panel Average 

The average amount of time it has taken to inspect each panel so far. 

Time/Panel Max 

The longest amount of time it has taken to inspect a panel so far. 

Time/Panel Min

The shortest amount of time it has taken to inspect a panel so far. 

Tolerance 

The threshold beyond which a measurement becomes a failure. 

U

Uninitialized 

The system has not performed a reference scan and is not ready for inspection. 

Upper Failure 

The upper limit for a given measurement. If a measurement exceeds this limit, it is considered 
a failure. 

Upper Limit 

The upper limit for a given measurement. If a measurement exceeds this limit, it is considered 
a failure.
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V

Valid (Reference Scan)

The system has performed a valid reference scan or has located valid reference scan data. 

Valid (Registration Data Results)

Registration flag that indicates whether the feature passed (P), had a boundary violation on 
one side (F1), or a boundary violation on opposing sides (F2). 

Vector 

Check this box to display lines showing the parent-to-child relationships of the elements. 

Valid/Possible 
● Valid is the number of features used to compute the registration. Invalid features, such 

as those with boundary violations or failed Height, Area, or Volume measurements, are 
not used in the calculations for overall registration measurements. 

● Possible is the total number of inspectable features on the selected element (location, 
image, or panel). 

Video Image 

Grayscale image of the current panel captured by the system sensor. The image shows the 
field of view that includes the selected feature. 

Volume 

The volume of a given feature as measured by the system. Volume measurements are given in 
cubic units. 

Volume Range 

The difference between the maximum and minimum volumes that the system has measured 
for the features of a given location. 

W

Write inspection results to CSV file 

Check this box if you want the Solder Paste Inspection application to create data files of 
inspection data. If unchecked, the application will not create data files. 

The data log files are stored in the CSV folder located within the SRFF output data folder. The 
location is specified in the Output Directory path above. The name of the log files are based on 
the name of the panel file, with .spi.csv appended to it. For example, if the name of the panel 
file is viper.srf, the names of the corresponding log files are viper.srf.spi.csv and 
viper.srf.reg.csv. 
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X

X 

The horizontal distance from the panel origin to the fiducial origin. Data is displayed for 
fiducials only. 

X Offset 

Amount of shift in registration across the feature, location, image, or panel measured in the X 
or horizontal direction. For features, this value represents individual measurements on the 
feature. For locations, images, and panels, this value is calculated from the feature-level 
measurements. Positive values indicate a shift to the right, negative values indicate a shift to 
the left. Tolerances cannot be set for this value. 

Y

Y 

The vertical distance from the panel origin to the fiducial origin. Data is displayed for fiducials 
only.

Y Offset 

Amount of shift in registration across the feature location, image, or panel measured in the Y 
or vertical direction. For features, this value represents individual measurements on the 
feature. For locations, images, and panels, this value is calculated from the feature-level 
measurements. Positive values indicate an upward shift, negative values indicate a 
downward shift. Tolerances cannot be set for this value. 

Z

Z Position

This value is not typically used. It can be used adjust the height of the base of a feature relative 
to the reference plane. Use the Collect Offsets setting in the Panel Options properties instead.
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